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[bookmark: _Toc399848114]Text Placement and Formatting
Use only Dreamweaver templates from the 004 development environments, as they include a number of built-in accessibility elements.
[bookmark: _Toc399848115]Consistency and Simplicity
Use consistent font sizes and types throughout the pages in your course.  This helps visually impaired, learning or cognitively disabled students process and locate information more easily and minimized distractions.
Some students with learning or cognitive disabilities find it much easier to process information when it is chunked in small sections.  Using bulleted or numbered lists can help with this greatly, and try to break up large areas of text with headings (see below), lists, tables, etc.
[bookmark: _Toc399848116]Font Size
Use em for font sizes, not or px or pt.  Example: <font size=”1em”>This would be large text</font>
If you are used to using pt or px, use this converter (http://pxtoem.com/) tool to convert from pt or px to em.
[bookmark: _Toc399848117]Headings
Use heading tags to convey headings, subheadings and hierarchy
<h1><h2><h3><h4><h5><h6>
<h1>This is the largest text</h1>
Headings tags can be found in Dreamweaver in the Properties tab, under the Format dropdown menu.
[image: ]
The lower the number, the higher in the hierarchy and the larger the font size.  When headings and subheadings use the heading tag, students can tab through different parts of the page quickly and easily.
Check out how headings are used in Microsoft Word for good examples.
[bookmark: _Toc399848118]Emphasis
The underline tag should be avoided in all text except URLs, as using in normal text confuses users as to what is a URL and what is not a URL.
Use the following tags for emphasis:
Bold: <strong>bolded word</strong>
Italic: <em>italicized word</em>
Italics should be used sparingly, as it can be difficult to read for visually impaired learners.
[bookmark: _Toc399848119]Abbreviations
As it is not easy for students using screen readers or assistive technologies to stop and go look up terms while they are reading text, use the abbreviation tag for acronyms and abbreviations, unless the full text is already included)
As these can be hard to spot in content, especially if it is lengthy, try to at least use the abbreviation tag below for the first instance of the abbreviation in the course.  Including the abbreviation tag on first instance of the abbreviation on each page is preferable.
<abbr title=”National Aeronautics and Space Administration”>NASA</abbr>
Exceptions:
· If the acronym or abbreviations is part of a citation or reference, it should be left alone
· If the acronym or abbreviation is used in a link, it can be left alone


[bookmark: _Toc399848120]Links
[bookmark: _Toc399848121]Link Formatting
Links should:
· open in a new window for consistency.
[image: ]
· use the destination of the link as the link title, not the URL itself.
· Proper:  Visit American Nurses Association
Improper: Visit http://www.nursingworld.org/
· include descriptors if they open any type of media:
	File Type
	Descriptors Needed
	Example

	PDF
	[File Type, File Size]
	Module 1 Readings [PDF, File Size 1.6 MB] 

	PowerPoint
	[File Type, File Size]
	Module 1 PowerPoint [PPT, File Size 2.6 MB]

	Video/ Embedded Video
	[File Type, Length]
	Accountants and Auditors [Video, 1:09 mins]

	Audio File
	[File Type, Length]
	Module 6 Podcast [MP3, 6:33 mins]



[bookmark: _Toc399848122]“Retrieved from” Citations
Citations that include “Retrieved from” URLs should be formatted as follows, with the title of the article, video, etc. linked:
Noesen, S. (Speaker). (2009, April 13). Sustainability is about managing complex change [Video file, 1 min 18 sec]. Retrieved from https://www-prendismo-com.vlib.excelsior.edu/collection/viewclip/14437



[bookmark: _Toc399848123]Mathematical/Scientific Equations
Use HTML codes for symbols when possible.
Example: &Delta; is code for Δ (all codes begin with & and end with ;)
Dreamweaver has many of the symbol codes pre-loaded.  In the Code View, type & and a dropdown menu will pop up with several choices.
[image: ]
If the symbol you are looking for is not already in Dreamweaver, there are lots of websites that offer the codes, here is one that is pretty comprehensive:
HTML Special Characters by Bruce Johnson (http://brucejohnson.ca/SpecialCharacters.html)
Superscript and subscript can also be used for equations.
Example: a<sup>2</sup> = a2
	    log<sub>10</sub> = log10
When it is not possible to use symbol codes and an image/screenshot of an equation or symbol must be used, use alternative text for the image that fully describes the equation.
Example: a2+b2=c2 in text form would be “a squared plus b squared equals c squared”


[bookmark: _Toc399848124]Tables
Tables should only be used to convey data, not to format text or images.
Tables must include the following HTML codes:
	<caption>title</caption>
	Inserts a title on top of the table that is visible to everyone and read by screen readers.  This helps to give an introduction on the function of the table.

	<table summary=”description”>
	Inserts a description of the table that is read by screen readers.  This helps someone listening to the table orient themselves with the data that they will be encountering.

	<th>
	Use instead of <td>.  Indicates which cells are headings.  This gives a label for each of the cells as they are read by a screen reader.  Using this code automatically bolds and centers the text.



	Example:

	Code:

	Locations and times of sessions

	Session
	Room
	Time

	A 
	212 
	3:45 

	B 
	209 
	4:15 

	C
	118
	4:45



	<table summary=”This table lists the rooms and times of Sessions A, B & C”>
<caption>Locations and times of sessions</caption>
<tr>
<th>Session</th>
<th>Room</th>
<th>Time</th>
</tr>
<tr>
<td>A</td>
<td>212</td>
<td>3:45</td>
</tr>
<tr>
<td>B</td>
<td>209</td>
<td>4:15</td>
</tr>
<tr>
<td>C</td>
<td>118</td>
<td>4:45</td>
</tr>
</table>



	Screen Reader Narration with <caption> and <th> tags:
	Screen Reader Narration without <caption> and <th> tags:

	Table 
Locations and times of sessions
Session A Room 212 Time 3:45
Session B Room 209 Time 4:15
Session C Room 118 Time 4:45
	Table
Session Room Time
A 212 3:45
B 209 4:15
C 118 4:45



In Dreamweaver, create a table by going to Insert -> Table.  Next choose the following properties to ensure that your table will be accessible:
 (
Entering a caption and summary here will add them to the table coding.
) (
Choosing a left, top or both 
header
 will automatically insert the table header tags in.
)[image: ]

[bookmark: _Toc399848125]Color
[bookmark: _Toc399848126]Using Color for Instruction
Do not use color for instruction – screen readers do not read colored text any differently than black and white text, and colorblind users may be unable to decipher the difference in colors.
	Do
	Don’t

	Fill out the fields marked with an asterisk*
*Name:
*Phone Number:
Birth date:
	Fill out the fields in red:
Name:
Phone Number:
Birth date:



[bookmark: _Toc399848127]Choosing Colors
Students with vision disabilities may have trouble viewing the difference between some colors and some with certain learning disabilities may have trouble processing information in a lot of different colors (looks very busy to them).
Use:
· high-contrast colors together (light on dark, dark on light).
· color sparingly to keep the look of the page simple.
· solid colored backgrounds (do not use backgrounds with images, patterns, or watermarks).

	Do
	Don’t

	 (
Heading
Text 
text
)
	
[image: ]



Color Checker: Vischeck (http://www.vischeck.com/vischeck/vischeckImage.php) will show you what an uploaded image (or screenshot) looks like to someone that is colorblind.  It is a very good and quick way to test if colors have enough contrast.

Note: While red/green color blindness is the most common, people can have a blue/yellow deficiency as well.  Individuals with poor eyesight can also have trouble with color contrast.

[bookmark: _Toc399848128]PDFs
PDFs need to be text-based, non-scanned documents or scanned using OCR (Optical Character Recognition) scanner software.
[bookmark: _Toc399848129]Checking for Accessibility
The easiest way to test to see if the document is text-based: place your cursor over the text and try to highlight a few words or sentences.  If you can highlight the words, it is accessible.  If you cannot, it is not.
	Accessible (Text-based)
	Not Accessible (non text-based)

	
[image: ]
	
[image: http://i.stack.imgur.com/dGRds.jpg]



[bookmark: _Toc399848130]Obtaining Accessible PDFs
What to do if you encounter a not accessible PDF in a course (in order of preference):
1. Request that the Program Director look for an alternative form of the document online, through the publisher, or in the Excelsior College library.
a. The publisher is responsible for either providing an accessible version, or giving permission for us to create an accessible version.  Every publisher may handle this differently, and in various amounts of time.
2. With permission, an original (preferable for quality) or scanned copy of the document can be scanned using OCR scanner or converted using an OCR tool.  The academic unit is responsible for verifying accuracy of scanned document.
Note: Although most articles in the Excelsior College library are accessible, not all are.  Jennifer Hall is currently working on a project to identify procedures for requesting accessible documents/files for each database in the library, if an accessible version does not already exist.
[bookmark: _Toc399848131]Graphics
[bookmark: _Toc399848132]Alternative Text
All graphics need to have an alternative text tag or alternative text tag and long description (title tag is not acceptable for accessibility)
<img src=”image.jpg” alt=”description of image”>
<img src=”image.jpg” alt=”description of image” longdesc=”imagedescription.html”>
Alternative text tags and long description files should:
· describe the point of the graphic to someone unable to see the graphic.
· not include the citation of graphic, as the alt tag should be kept simple and descriptive of only what is going on in the graphic.
· include any text contained on the graphic (this is common in diagrams and charts), including any captions that are part of the image (not text-based)
	Graphic
	Appropriate alt text tag

	[image: http://www.myschoolhouse.com/courses/C/4/Images/earth.gif]
	<img src=”earth.jpg” alt=”earth’s layers labeled going internal to external, inner core, outer core, mantle, crust”>



To add an image in Dreamweaver, go to Insert -> Image.  After selecting the image, add the alternate text in the window that pops up.
[image: ]
Images that are used as URLs also need to have an alternative text tag.
Example: <a href=http://www.google.com><img src=”google_logo.jpg” alt=”Google Logo”></a>
When to use just alt and when to include longdesc:
If the text needed to describe the image is more than a sentence or two, a long description should also be used.  The long description is a plain HTML file with only the text describing the image.
[bookmark: _Toc399848133]Animated Graphics
Animated graphics need to include player controls (stop, play, pause, etc.) and should not automatically play when the page is loaded.
[bookmark: _Toc399848134]Charts as Graphics
If at all possible, charts should be in the form of data tables, not screenshots.
[bookmark: _Toc399848135]Media
The standards below only apply to media that is hosted within a course, not to files on external websites.
All multimedia should be saved with the naming conventions and locations specified in the Multimedia Storage Instructions document.
[bookmark: _Toc399848136]Embedded audio and video
All audio and video files that are embedded on a page must:
· have controls (play, stop, pause, etc.).
· be set to not play automatically when page loads.
[bookmark: _Toc399848137]Flash-Based/Non Text-Based Media
All flash-based and non text-based media needs to include a plain-text file, linked next to or underneath the media file.  The plain-text file needs to include all text on each page or slide, and needs to be formatted as simply as possible.
Example: Module 1 Interaction (Module 1 Interaction Plain Text Version) 
Programs we use that are Flash-based (amongst others):
· Articulate Engage
· Articulate Storyline
· Raptivity
· Adobe Captivate
[bookmark: _Toc399848138]Audio and Video Transcription
All audio and video files that are hosted within the course must include a plain-text transcript.
	Needs to be transcripted:
	Does not need to be transcripted:

	· files on our multimedia server
· videos and audio files hosted within the course (found in the Content Collection)
· Adobe Presenter files (see below)
· Adobe Connect presentations
	· youtube videos
· Excelsior College Library media
· anything hosted on an external website that we link out to



[bookmark: _Toc399848139]Adobe Presenter Files
Adobe Presenter Files only need transcripts if the following conditions are met/not met: 
	Has audio narration?
	Narration matches text on PowerPoint slides exactly?
	Narration matches text in Notes tab?
	Needs transcript?

	No
	N/A
	N/A
	No

	Yes
	Yes
	N/A
	No

	Yes
	No
	Yes
	No

	Yes
	No
	No
	Yes



[bookmark: _Toc399848140]
Helpful Resources

	General Accessibility:

	Information and Technical Assistance on the Americans with Disabilities Act
	http://www.ada.gov/

	Excelsior College’s Accessibility Project Overview:


	http://www.ipsonet.org/images/Westphalia_Press/Internet_Learning_Journal_2-2/3-1/2.%20Blauvelt%20ILJ%203-1.pdf

Blauvelt, E. (2014). Get Rid of the Gray: Make Accessibility More Black and White!. Internet Learning. 3 (1), 16 - 24. Retrieved from http://www.ipsonet.org/publications/open-access/internet-learning

	Webinars/Training:

	Sloan-C Accessibility Webinars Recordings
	http://sloanconsortium.org/institute/webinars/accessibility-series

	***Sloan-C Accessibility Specialists: Understanding “Invisible” Disabilities & What this Means for Online Education
	http://sloanconsortium.org/institute/webinars/2013/4/accessibility-specialists-understanding-invisible-disabilities-what-mean

	EASI (Equal Access to Software and Information) Training
	http://easi.cc/

	Videos:

	Keeping Web Accessibility in Mind
	https://www.youtube.com/watch?v=yx7hdQqf8lE

	Standards:

	WCAG (Web Content Accessibility Guidelines)
	http://www.w3.org/TR/UNDERSTANDING-WCAG20/

	W3C WAI (Web Accessibility Initiative)
	http://www.w3.org/WAI/

	Section 508 Standards Guide
	http://www.section508.gov/index.cfm?fuseAction=stdsdoc

	Technical Information:

	HTML Symbols Codes
	http://brucejohnson.ca/SpecialCharacters.html

	HTML Code Help
	http://www.w3schools.com/html/default.asp

	Vischeck (shows colorblindness and contrast)
	http://www.vischeck.com/vischeck/vischeckImage.php

	Pt to em font size converter

	http://pxtoem.com/
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CIRCULATIA ARTERIALA 355
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